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Contact Information 
 
Wilson Analytical Services Inc., 
Northern Alberta Business Incubator (NABI)   
13 Mission Avenue, St. Albert, AB, T8N 1H6 
 
Email:  info@wilsonanalytical.com 
Phone: (780) 702-0610 
Toll free: 1-866-3wilson (394-5766)     
Website: www.wilsonanalytical.com  
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Installing and Running LightPilot Software 
 
If you are using a netbook or other computer supplied by Wilson Analytical, LightPilot will have already 
been installed and configured. Once the netbook or computer is running, double-click the blue icon to 
launch LightPilot. 
 

 
Figure 1. The Wilson Logo used as the LightPilot icon. 

 
If the LightPilot software has not already been installed on your computer, the program can easily be 
installed, either by inserting the LightPilot USB flash drive that was supplied, or by downloading the 
latest version of the software from the Wilson Analytical website, at www.wilsonanalytical.com.  
 
To install LightPilot, follow the steps below: 
 
Double click on the LightPilot setup exe and follow the prompts to install the software. After installing 
the software go to Program Files on your computer. In order to do this, open up File Explorer, then 
click on ‘This PC’. You will then be brought to ‘Devices and Drives’ where you can click on your 
Windows' Drive, such as Windows (C:). Once you are in your Windows' Drive double click on the 
folder titled Program Files. In the Program Files folder, find and open the folder that says Wilson 
Analytical, then double click on the folder ‘LightPilot QB’.  
 
Once you are in the LightPilot QB folder ensure ‘OmniDriverSPAM-2.46-win64-installer’ is installed by 
double clicking on it and following the prompts. When you must choose which version to install click on 
‘Redistributable version’ then click next. When you are asked if you want to install VCREDIST silently 
click on ‘Yes’ then click next. Next ensure ‘jdk-8u121-windows-x64’ is installed by double clicking on it 
and following the prompts. When selecting optional features to install make sure ‘Development Tools’ 
is highlighted then click next. Finally ensure ‘vc_redist.x64 and ‘vc_redist.x86’ are installed. If you are 
prompted that ‘Setup Failed’ because another version is already installed, do not worry. This most 
likely means the program has already been installed properly so all you need to do is click on close.  
  

http://www.wilsonanalytical.com/
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In all cases you will be alerted when the installation is complete, at which point rebooting the system is 
recommended. Once the system comes back up, you can launch LightPilot by double-clicking the blue 
icon on the computer desktop. If complications persist do not hesitate to contact us. 
 
Once the software has been successfully installed, the LightPilot Software can be used to control any 
version of Wilson Analytical instrumentation. If you are not using the WhereBox (GPS receiver) an 
error message may appear prompting you to connect the GPS device. If you wish to run the software 
without the Wherebox, simply open the 'Tools' menu on the toolbar and select ‘Change Setup’. This 
will open a dialog box asking you to enter the current password. Once you have entered the password, 
the setup window will open. Ensure the ‘Require GPS’ box at the bottom of the setup pop up is 
deselected and you will be able to run LightPilot without the WhereBox. 
 

 

 
Figure 2. GPS error message that may pop up if the WhereBox is not connected. 

 
 
  



 
 
 

 

 5 

 

Overview of LightPilot Software 
 
The LightPilot software was designed to make using Wilson Analytical instrumentation a 
straightforward and enjoyable process, while still ensuring that the data obtained is both accurate and 
reliable. Scientific jargon and complexity have been kept behind the scenes as much as possible, and 
the user is guided through the measurement process in a clear and logical fashion. The first thing to 
know is that the LightPilot software has three modes of operation, each dedicated to a particular task. 
Each of the modes is discussed in detail in the remainder of this section. The three modes are: 
 
Control mode, used to create or modify a calibration curve for the chemical or chemicals that will be 
monitored; 
Acquisition mode, used to take measurements on the samples of interest; and 
Review mode, used to display, review and print data files. 
 
The user can switch between these modes using the ‘mode’ menu in the toolbar. Note that because 
the validity and the accuracy of its data hinges on the quality of the calibration curves created by the 
user, access to the Control mode is password protected. 

 

 
Figure 3. The ‘Mode’ menu located in the toolbar allows the user to switch between the Acquisition, Review and 

Control Modes. 

 
In each of the three LightPilot modes, the software has been designed to guide the user through the 
completion of the appropriate activity (calibration, acquire data, review data) in a logical sequence. For 
example, Acquisition mode will not allow a chemical sample to be measured until a calibration curve 
for that chemical has been selected. The software guides the user by having steps grayed out until 
they are ready to be completed. 
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Note that the LightPilot software has been designed so that it can be used without a mouse. Each of 
the selection buttons in all the modes can be activated by pressing the appropriate function key on the 
keyboard, for example ‘Acquire Baseline [F1]’ 
 

 

LightPilot Setup 
 
Though a default password to access the Control mode has been supplied with the instrument, you 
are not required to keep this password. It can be changed it by simply opening the 'Tools' menu on the 
toolbar and selecting ‘Change Setup’. This will open a dialog box asking you to enter in the current 
password. Once you have entered the password, the setup window will open (see Figure 4). 

 

 
Figure 4. The setup window allows the user to change the password, test the GPS settings, test the 

Spectrometer settings, change the require GPS option and more. 

 
From the setup window, you can change your password simply by deleting the existing password from 
the password text box and entering in the new password. The setup window also allows you to test 
your connections with both the WhereBox (GPS receiver) and the spectrometer, to ensure that both 
are connected and working properly. To do a check, click ‘Test’ beside the appropriate device in the 
dialogue box (see Figure 4).  
 
Finally, the setup window is where you can choose to autosave after each acquisition run and/or set 
the GPS and the spectrometer requirements. In Figure 4, the ‘Require GPS’ box at the bottom of the 
setup window is deselected, allowing the user to run samples without the GPS. To save the changes, 
click ‘OK’ at the bottom right hand side of the window, once you have saved the settings, they will 
remain the same even once you exit LightPilot.  
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LightPilot Data Spectrum and Cursor 
 
The default view on the software is to display the baseline, the raw spectrum, and the data, however 
you do not have keep this setting. To change the data spectrum that is displayed simply open the 
'View' menu on the toolbar, hover over ‘Data Spectrum’ and deselect the datapoints you do not want 
displayed (see Figure 5). It is important to remember that the default setting will be displayed each 
time the program is closed and reopened, meaning you will have to change the view each time you 
open the software.  
 

 
Figure 5. The View menu located in the toolbar allows the user to edit the viewing settings on LightPilot, 

including the Data Spectrum. 
 

In each of the three modes, it is possible to view the number of spectrometer counts (intensity) at 
varying wavelengths by opening the 'View' menu in the toolbar and selecting ‘Cursor’. A dialogue box 
will open, called ‘Cursor’. From here, you can select the wavelength at which to display the counts. By 
default, the cursor is set to the lowest wavelength at the far left of the graph when it is opened (see 

Figure 6).  
 

 
Figure 6. The cursor dialogue box. 

 
There are two ways to adjust the wavelength: to change by large intervals, move the scroll bar side to 
side; to move by smaller intervals (0.2 nm of a wavelength), click on the left and right arrows to either 
side of the scroll bar. Note that the cursor line starts at the left of the spectrum (short wavelength end). 
Using this cursor, you can determine the height of any peaks that appear on the graph. The 
wavelength being read at any given time is represented on the graph as a vertical black line.  
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‘Control’ Mode Introduction 
 
LightPilot works by taking the measurement of the fluorescence intensity from an unknown sample and 
comparing it to the expected intensity from the same chemical, measured at a series of standard 
concentrations. The chart of ‘fluorescence intensity versus concentration’ for any given chemical is 
called its calibration curve.  
 
Without a calibration curve, the data measured by the instrument is useless, and so it is the purpose of 
the Control mode to guide the user through the creation and/or modification of calibration curves. The 
necessary steps are listed on the left-hand side of the Control mode screen. In this section, we will 
discuss each of these steps in turn.  
 
Choose ‘Control’ from the ‘Mode’ menu located on the toolbar, and a password dialog box will open. 
Type in the password to access the Control Mode (see Figure 7).  
 

 
Figure 7. The password dialog box pops up to access the Control Mode. 

 

Once you have accessed the Control Mode follow the appropriate activities from top to bottom starting 
with the ‘Substance Name’. Let us assume that we want to create a calibration curve for a corrosion 
inhibitor chemical called Corrosion Inhibitor (CI)-A. Type in ‘CI-A’ (no need to type the quotes) in the 
‘Substance Name’ text box. When the calibration file is saved, at the end of the process, it will be given 
the name ‘CI-A.cal’ (again, without the quotes). More information can be added to the name if multiple 
calibration curves will be needed for the same chemical. For example, ‘CI-A’ could be ‘CI-A 1ppm -
100ppm OPS 07-Aug-2020.  If you are re-doing a calibration curve for a chemical, we recommend 
copying and pasting the previous calibration name into the new curve and then changing the date. 
This ensures proper consistency and organization. 
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Each instrument contains a spectrometer with a unique serial number. The LightPilot software keeps 
track of the spectrometers used to create calibration and data files, and you may occasionally see a 
warning alert that data you are using was created with a different unit. This is perfectly normal and 
there is no reason for the user not to proceed with measurements using calibration curves created on 
other Wilson instruments. The light output from each instrument has been carefully calibrated to be 
equivalent, so that clients with more than one unit can work efficiently by sharing data and calibration 
curves as desired. However, this is assuming the instruments are using the same wavelength for the 
light source and the same type of spectrometer. Various light sources are available for installation 
during the construction of the unit.    
 
There is a drop-down menu immediately below the ‘Substance Name’ text box (see Figure 8), which 
allows the user to select the instrument that is currently detected by the LightPilot software, or devices 
that have been detected in the past. In most cases, only one serial number will appear. In the event 
that two or more serial numbers are displayed, the user should select the unit that will be used for their 
testing. 

 

 
Figure 8. Image of the ‘Substance Name’ text box and the instrument drop down menu located at the top left-

hand corner in the Control Mode. 
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Three Spectroscopy Parameters for Calibration in the Control Mode 
 
Wilson Analytical’s fluorescence instrumentation exposes a sample to a constant source of light and 
records the intensity versus wavelength of the light that is re-emitted by the sample. This ‘emitted 
intensity’ is recorded as the number of counts at each wavelength between 380nm and 1100nm and is 
displayed by the LightPilot software as a spectrum on the computer screen. Different chemicals emit 
light at different characteristic wavelengths, and the normal procedure is to pick a wavelength of 
maximum intensity (i.e., a peak) as the wavelength for the calibration of a particular chemical.  
 
The next step is to choose values for the three-spectroscopy parameters required to take a 
measurement. These parameters are: 
 
Parameter 1: Integration Time 
Parameter 2: Scans to Average 
Parameter 3: Boxcar Width 
 
Now these parameters may not mean much to you, but they are important and will affect the intensity 
of the fluorescence signal and the quality of the data that you obtain. The parameters have the 
following effect: 
 
Parameter 1: Integration Time 
 
Think of integration time like the shutter speed on a digital camera. The longer the integration time, the 
longer the ‘shutter’ is open, and the more light (signal) reaches the detector. Just like in photography, 
you want your picture (your data) to have the right exposure. Too much exposure, and you will lose 
contrast and linearity. Too little, and you will lose sensitivity and be unable to measure low 
concentrations accurately. And just like in photography, you sometimes have to play around with the 
settings a little bit to get the exposure just right! 
 
If we are planning to use CI-A at 500ppm, we might want a calibration curve that spans 50ppm (10x 
lower) to 2500ppm (5x higher). Though this would be ideal we must remember that one of the four 
secrets to accurate fluorescence measurements is staying in the linear range, and the maximum 
concentration that we can measure directly in the linear range may be as low as 50ppm. As the 
dilution factor in this case must be at least x50, we may as well pick x100, as this gives us a margin of 
safety, plus easier arithmetic. With a dilution factor of x100, the calibration for CI-A will require samples 
with concentrations ranging from 0.5ppm to 25ppm, for example 1ppm, 5ppm, 10ppm and 25ppm. If 
necessary, more concentrated samples at 50ppm and 100ppm could be prepared, to see at what 
point, and to what extent, the calibration curve becomes non-linear. 
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The basic principle in selecting the correct integration time is that a doubling of the time will double the 
amount of light reaching the detector, and hence double the number of counts recorded in the 
spectrum. The detector will show a maximum of 64,000 counts at any wavelength, so the integration 
time in this case must be such that at 25ppm, the maximum number of counts is less than 64,000. At 
the low concentration end of the measurement, we would like to be able to see 0.5ppm reliably, and 
the minimum number of counts necessary to do this is around 10. In the middle of the range, where we 
hope to see most of our samples fall, we would like the 5ppm sample to have hundreds or maybe a 
couple of thousand counts at the chosen wavelength. 
 
In most cases, there will be a range of integration times that are suitable to allow the user to ‘see’ the 
concentration range of interest quite comfortably.  A good starting point for the integration time is 
250ms (250 milliseconds). If there are insufficient counts at the low end of the concentration range, 
increase the integration time. Conversely, if there are tens of thousands of counts at the high end of 
the chosen range, decrease the integration time accordingly.  
 
Note that if for any reason a single integration time value that covers the whole concentration range 
appropriately cannot be found, the user has two choices. The first is to select a value of the integration 
time that makes the low concentrations ‘work’, and simply further dilute samples that are off scale. Or 
secondly, construct two calibration curves, one for higher concentrations, and one for lower.  
 
It is important to note that once an integration time has been chosen, and a measurement taken, all 
further measurements for that calibration curve will use the same integration time. This feature is hard-
wired into the Control mode so that the user cannot inadvertently take measurements with different 
parameters and try to construct a single curve. It only makes sense to take sample measurements with 
the instrumentation set up in the same configuration that was used to construct the calibration curve. 
This is one of the things that the LightPilot software looks after “behind the scenes”.  
 
Parameter 2: Scans to Average 
 
This parameter is fairly self-explanatory. It is simply the number of fluorescence measurements that 
the instrument will obtain and average together before displaying on the screen. A big advantage of 
the fluorescence technique is the speed at which measurements can be taken; a few seconds at most. 
It is a good idea to take multiple data sets and average them together, as it takes so little time to do so, 
and the statistical accuracy of the data is thereby improved. A good default value for this parameter is 
32, and the user can decide through experimentation if there is a particular advantage in a greater or 
lesser value. 
 
As with the integration time, once the ‘scans to average’ parameter has been set, and a measurement 
taken, all further measurements for that calibration curve will use the same value. 
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Parameter 3: Boxcar Width 
 
The boxcar width is a technical parameter that has to do with smoothing of the data. A default value of 
20 is acceptable for most applications, and in most cases, the user will see little difference from 
adjusting its value. Boxcar width has been retained as a parameter for the more expert user, and for 
those requiring the most extreme precision in their work. 
 
As with the ‘integration time’ and ‘scans to average’ settings, once the ‘boxcar width’ parameter has 
been set, and a measurement taken, all further measurements for that calibration curve will use the 
same value. 
 
Thresholds 
 
Beneath the boxes for 'integration time', 'scans to average' and 'boxcar width' are four boxes labeled 
"Thresholds". Of these boxes, the middle two are 'greyed out', while the leftmost and rightmost ones 
can have data entered into them.  
 
The two 'greyed out' boxes represent the range of the calibration curve, that is the lowest and highest 
ppm standard measured in making the curve, respectively. These boxes will fill in automatically as you 
make your calibration curve. 
 
The leftmost white box allows you to enter the lowest ppm sample that falls outside the range of the 
curve you want to be reported. The rightmost white box, similarly, lets you enter an upper threshold, or 
the value that falls above the range of the curve that you want to be reported. Those values that fall 
into the areas between the threshold values and the range of the curve will be reported in orange, 
while those that fall outside the threshold values will be reported in red. Values that fall within the 
range of the calibration will be green. 
 
Note that it is not mandatory to set threshold values; if you leave them blank, they will be assumed to 
be the range of the curve, and thus any values falling outside the range of the curve will be reported in 
red. 
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Creating the Calibration Curve  
 
The next step is to take a measurement with a ‘blank’ sample. This gives the instrument a baseline 
response (from the cuvette, solvent, etc.,) that is subtracted from all subsequent sample 
measurements. The blank sample should be the same as the calibration standards in all respects 
other than the chemical you are measuring. For example, if you decide to make the calibration 
standards for CI-A in a 95% water, 5% isopropyl alcohol (IPA) solution that contains 100ppm of 
sodium chloride, then this solvent matrix should be used for the blank measurement.  
 
To acquire a spectrum from the blank sample, check that the instrument is ready as indicated by the 
green status LED’s, open the hat on the Cuvette holder or take off the lid on the Solid Sampler and 
insert the blank sample. Note the red LED turns on when the sample holder’s hat or lid is off. When 
you close the hat or put on the lid, the Interlock LED should turn green. If it is red, the Cuvette Holder 
hat is not closed, or the Solid Sampler lid is not on properly. When the blank is in the sampler holder 
and the LED’s are green, select ‘Acquire Baseline’. When the measurement is complete (Power or 
data LED on the front changes from blue to green), remove the blank sample. The baseline spectrum 
will be displayed, as well as the zero concentration counts at the calibration wavelength (see Figure 9). 

 

 
Figure 9. Image of the blank sample, also referred to as the baseline. The written values are shown in the box 

located under ‘Acquire Baseline’, while the visual spectrum display box is on the bottom right of the screen. 

 
Now that the three-spectroscopy parameters have been configured, and a baseline measurement has 
been taken, the actual calibration curve for CI-A can be created.  
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One way of developing a calibration curve is to create a ‘dilution series’ of the chemical of interest in 
distilled or deionized water. For example, a series of samples with 1ppm, 5ppm, 10ppm, 25ppm and 
50ppm concentrations of chemical would form a very good calibration sequence. In practice however, 
chemicals are used in ‘real world’ water systems that may or may not contain salts, surfactants or 
other chemicals that could potentially interfere with the fluorescence measurement. Therefore, if 
possible, it may be a good idea to use the same environment, or sample matrix as found in the field to 
prepare the calibration samples.  
 
For example, if a corrosion inhibitor is being used at 500ppm in a system where the produced water 
has a salinity of 5% (50,000ppm), a useful calibration series could be formed by making an accurate 
500ppm solution of inhibitor in the produced brine and diluting it by factors of x50, x100, x500, x1000 
and x5000, to give solutions of 10ppm, 5ppm, 1ppm, 0.5ppm and 0.1ppm. Alternatively, solutions of 
10ppm, 5ppm, 1ppm, 0.5ppm and 0.1ppm could all be prepared in a 100ppm brine (corresponding to 
the expected strength of the matrix; 500ppm in a 50,000ppm brine, diluted by x500).  
 
Note that it is not necessary to prepare five or six samples to create a calibration curve. The Control 
mode will assume that the fluorescence intensity at zero concentration (0ppm) will be zero, i.e., all 
calibration curves go through the origin. Therefore, even a single sample, say 10ppm, will result in a 
straight-line calibration that could be used for subsequent measurement of unknowns. A two-point 
calibration is however ill-advised, because it will not confirm that you are operating in the linear range 
and can easily result in large errors between the measured and actual chemical concentrations.  
It is advisable to use at least three chemical dilutions to create a calibration, and the concentrations 
chosen should cover at least an order of magnitude in concentration range. In other words, 1ppm, 
10ppm and 50ppm will create a much better calibration curve than 1ppm, 2ppm and 5ppm.  
 
Let us say that we have prepared five calibration samples for CI-A, at 1ppm, 25ppm, 50ppm, 75ppm, 
and 100ppm. Place a cuvette containing the 1ppm solution into the sample holder and close the 
sample cover. Type ‘1’ in the white text box that appears between the symbols ‘Conc.’ and ‘ppm’, and 
then select the ‘Add Concentration’ button (see Figure 10). The fluorescence spectrum from the 1ppm 
sample will be displayed on the lower right-hand side of the Control screen.  
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Figure 10. 1ppm Concentration sample about to be tested, with 1 typed into the Concentration text Box. 

 
LightPilot will now construct a data table that shows the concentrations run so far, the units, counts 
and raw counts. This data is the beginning to the calibration curve and displayed graphically on the 
upper right-hand side of the screen.  

 
Proceed with the creation of the rest of the calibration curve by adding the 25ppm, 50ppm, 75ppm, and 
100ppm concentrations in the same way as you did for the 1ppm sample. For each concentration, 
place the cuvette with the new concentration in the cuvette holder, close the cover, type the new 
concentration in the text box, and select ‘Add Concentration’.  
 
If at any time you make a mistake, or simply wish to remove one or more of the data sets, simply 
highlight that measurement or measurements by clicking on them and then select ‘Delete Selected 
Concentration(s)’. You can delete a sample if something was typed incorrectly or if you would like to 
redo a data point.  
 
When you have measured all six calibration samples, you should see six spectra displayed at the 
bottom right-hand side of the screen in the spectrum display box, each with the same shape (peaks in 
the same place) but with different intensities (see Figure 11).  
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Figure 11. Image of the spectrum display box in the Control Mode with six different concentrations of a sample 

measured. 
 
In the spectrum display box, there is a single vertical line (See Figure 11). To complete the creation of 
the calibration curve, you must select a calibration wavelength by moving this vertical line to the proper 
wavelength. In order to move the vertical line, type in a wavelength into the text box to the right of 
‘Choose Calibration Wavelength’. So, for example, if you see that your fluorescence spectra have 
peaks around 503nm, then type “503” into the ‘Choose Calibration Wavelength’ box (see Figure 12).  

 

 
Figure 12. 503 nm Calibration Wavelength has been chosen and typed into the appropriate text box. 
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The vertical line will move to 503nm in the spectrum display box, and you should now see a linear 
calibration curve in the graph box on the upper right-hand side of the screen that is close to linear (see 
Figure 13). If the vertical line in the spectrum display box is not at the peak maximum, simply adjust 
(move) the line by typing a different number into the Calibration Wavelength box. For example, if the 
line is too far to the right, try typing ‘500’ in the Calibration Wavelength box and the line will move 3 nm 
to the left from the previous 503 nm Calibration Wavelength. 

 

 
Figure 13. Linear calibration curve in the graph box on the upper right-hand side of the Control Mode, and the 

spectrum display box on the bottom right-hand side of the Control Mode with the vertical line at the peak 
maximum. 

 
At this point, the user has complete control over the calibration and can add or subtract samples with 
different concentrations, or can choose a different wavelength for the calibration, until calibration curve 
at the top right-hand side of the screen is as linear as possible. The equation of the calibration curve 
and the R squared value are calculated and displayed immediately underneath the ‘Choose 
Calibration Wavelength’ box. This provides the user with more information regarding the linear trend. 
An R squared value of 0.98 or greater is ideal when making a calibration curve. 
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The final step is to save the calibration curve by simply selecting ‘Save Curve’ at the bottom left-hand 
side of the screen (see Figure 13). Once you have done this, the ‘Save As’ dialogue box will pop up 
which allows you to choose where the calibration curve is saved, and the name of the calibration curve 
(see Figure 14). Once you click on ‘save’ the calibration curve has been successfully created and it 
can be used in the Acquisition mode. 
 

 
Figure 14. After the user clicks on ‘Save Curve’ the ‘Save As’ box pops up allowing the user to choose where 

the calibration curve will be saved and the name it will be saved under. 
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‘Acquisition’ Mode Introduction 
 
Once a calibration curve has been successfully created, Wilson’s instrumentation can be used to 
determine chemical concentrations in unknown samples. From the toolbar, select the ‘Mode’ menu, 
and then Acquisition. No password is required, and the Acquisition screen will be displayed.  
 
Acquisition mode breaks down the measurement of each sample into five sequential steps, and the 
user is guided through each of the five in turn. The LightPilot software makes it impossible to take the 
steps out of sequence, although it is possible to go back and change previous steps. Options that are 
not yet available for a particular sample are ‘grayed out’ (see Figure 15). For example, once step one 
has been completed, step two becomes available. Once that has been completed, step three is 
available, and so on. 

 
The five steps are: 

Entering information about the sample (e.g., name and location) 
Selecting a calibration curve  
Measuring a blank sample 
Measuring the unknown sample 
Saving the data file. 

 

 
Figure 15. The Acquisition Mode with the five steps displayed on the left-hand side of the screen. Note the first 

step ‘Customer/Location’ is the only step available for use at this point.  
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Entering Information  
 
After clicking ‘Customer/Location [F1]’ in the Acquisition Mode, the Customer Information dialogue box 
appears allowing you to enter in information about the customer and sample. While entering in 
information you have the option to use the WhereBox unit, or not. If you choose to use the WhereBox, 
the GPS coordinates, the date and the time will be displayed at the top of the screen in the Customer 
Information dialogue box. If you choose not to use the WhereBox the GPS field will just contain default 
letters and question marks that can be safely ignored (seen in Figure 16). 
 

 
Figure 16. Customer Information dialogue box that allows the user to enter in Customer or Sample information. 

Note in GPS location the data is unknown because the Wherebox is not in use. 
 
For the WhereBox to work, it must be placed in a location where a GPS satellite radio signal can be 
reached. It is best to place it out in the open; if indoors, it is best placed as near to the door as 
possible, especially if you are below ground. The bottom of the WhereBox is also magnetic, allowing it 
to be stuck to any metal surface, such as the roof of a truck or the wall of a metal shed. This helps to 
improve the range of places the WhereBox can be set up, allowing for the best GPS satellite radio 
signal possible.  
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If you choose not to use the WhereBox, simply open the 'Tools' menu on the toolbar and select 
‘Change Setup’. This will open a dialog box asking you to enter in the current password. Once you 
have entered the password, the setup window will open. Ensure the ‘Require GPS’ box at the bottom 
of the setup pop up is deselected and you will be able to run LightPilot without the WhereBox. 
 
Once you are in the Customer Information dialogue box (see Figure 16) you may notice that beside 
the ‘Name/Company’ and ‘Location/Sampling point’ boxes, there are arrows. You can click these 
arrows to open a dropdown menu of previously entered sample locations and company names. 
Selecting one of these will save you from having to enter this information multiple times if you are 
sampling at the same location. To save a new name or location you can click the ‘Save As’ button to 
the right of the ‘Location/Sampling point’ box. In future visits, if all the information remains the same, 
including the GPS coordinates, if you are using the WhereBox, you can simply click ‘Browse’ (located 
above the ‘Save As’ box) and select the location to fill in the company and location information. 
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Selecting a Calibration Curve 

 
As discussed earlier, the user must select a calibration curve that LightPilot can use to calculate the 
chemical concentration of the unknown sample. This is straightforward to do by selecting ‘Select 
Calibration [F2]’. A list of files with the ‘.cal’ extension will be displayed (see Figure 17). Simply select 
the calibration file that you wish to use, and LightPilot will use that particular calibration curve to 
determine the concentration of chemical in the unknown sample(s). Following the earlier example of 
the calibration curve that was created for CI-A, click on ‘Select Calibration [F2]’, and then select the file 
named ‘CI-A 1ppm - 100ppm OPS 1084 07-Aug-20” as seen in Figure 17.  

 

 
Figure 17. This window pops up after clicking ‘Select Calibration [F2]’ in the Acquisition Mode. Note there is 

only one Calibration Curve saved. 
 

Once a calibration file has been selected, LightPilot reads the three-spectroscopy parameters that 
were used to create that calibration (Integration Time, Scans to Average and Boxcar Width) and uses 
them for the subsequent measurements of the unknown. The user cannot change the spectroscopy 
parameters from the Acquisition mode. This is because it makes no sense for measurements on 
unknowns to be interpreted using a calibration curve obtained with different spectroscopic conditions. 
As LightPilot forces measurements to be taken under the same conditions as the calibration, the user 
doesn’t have to check back or worry about ensuring there is a match. 
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Measuring a Blank Sample 
 
Once the user has entered information about the sample and selected a calibration file, the next step 
is to take a measurement with a blank sample. This gives the instrument a baseline response (from 
the cuvette, solvent, etc.,) that is subtracted from the subsequent sample measurement. As discussed 
earlier, if it is possible the blank sample should use the same solvent matrix as the calibration 
standards. 
 
To acquire a spectrum from the blank sample, check that the instrument is ready as indicated by the 
green status LED’s. Insert the blank sample into the sample holder and close the cover. The Interlock 
LED should turn red when the sample holder’s cover is open and green when the sample holder’s 
cover is closed.  

 
Once the LED’s on the front panel are green you are ready to take measurements. Click ‘Measure 
Blank Sample [F3]’, and the software prompts you to ensure that the blank sample or the zero-
concentration sample, is in place before proceeding (see Figure 18). After clicking on ok wait until the 
Power or data LED changes from blue back to green, and then remove the sample. 

 

 
Figure 18. The window that pops up to ensure the blank sample has been placed in the instrument. 

 
The fluorescence spectrum of the blank sample will be displayed on the computer screen. It is likely to 
be relatively uninteresting as it is a control sample. If the spectrum does contain peaks or features, 
there is a good chance the blank contains a fluorescent chemical or that the wrong sample has been 
selected (i.e., the sample isn’t really a blank). If the blank contains fluorescent material, the user must 
be cautious that it does not interfere with the sample measurement.  
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Before measuring the unknown sample, it is advisable to run the blank itself as a sample, to ensure 
the instrumentation is running properly. While it is not a necessary step in running a sample, running 
the blank as a sample can tell you early on if there is something wrong with your blank, or if the 
instrumentation is misreading the sample.  
 
When the blank is run as a sample “against itself”, the result may be somewhat noisy but should 
approximate a straight line as this is the same material running as both the blank and the sample and 
they should therefore cancel each other out. However, if there is a noticeable deviation from a straight 
line, you should either start over (i.e., redo the blank measurement) with the same blank, or prepare a 
new blank, to ensure the best results. Doing this serves as a sort of safeguard and ensures the 
instrument is working properly. It is not uncommon to have to rerun the blank a couple of times when 
the instrument is first started.  

 
The default view on the software is to display the baseline, the raw spectrum, and the data, however 
you do not have keep this setting. To change the data spectrum that is displayed simply open the 
'view' menu on the toolbar, hover over ‘Data Spectrum’ and deselect the data points you do not want 
displayed. It is important to remember that the default setting will be displayed each time the program 
is closed and reopened, meaning you will have to change the view each time you open the software.  
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Measuring an Unknown Sample 
 
Insert the unknown sample into the sample holder and close the cover. Proceed as before until the 
status LED’s on the front panel are all green. Click ‘Measure Data [F4]’ and the ‘Modify sample 
specifics’ dialogue box appears to allow for any corrections to the sample information (see Figure 19). 
The next step is to type the dilution factor for the sample in the text box provided. For example, if the 
original sample was diluted by a factor of x100 prior to measurement, the user should type ‘100’ 
(without the quotes) into the ‘Dilution Factor’ text box. If no dilution was used, ensure that the dilution 
factor is set to ‘1’. Once the information has been entered and the dilution has been recorded, click on 
‘Measure’. Wait until the Power or data LED changes from blue back to green, and then remove the 
sample from the instrument. 

 

 
Figure 19. The ‘Modify sample specifics’ dialogue box that allows the customer to enter in additional information 

about the sample being measured and the dilution factor. 
 

The fluorescence spectrum of the unknown sample will be displayed on the computer screen. The 
spectrum display will show a vertical line at the wavelength selected for the calibration calculation (see 
Figure 20). Typically, this will correspond to a peak in the fluorescence spectrum from the test sample. 
Note that the calibration wavelength cannot be changed at this point; it is displayed for reference only. 
 
LightPilot will now calculate the actual concentration of the target chemical in the original sample, 
based on the dilution factor and the calibration curve that has been selected. For example, if the result 
of the measurement is 3.27ppm, and the dilution factor is x100, the result written at the top of the 
screen will be 320ppm. The result displayed at the top left-hand side of the screen will be green if it is 
within the range of the calibration curve as seen in Figure 20, and red if it is out of the calibration 
range. 
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Figure 20. The measured spectrum displayed on the bottom right of the screen, with the vertical line indicating 

the calibration wavelength. Note the calibration file is displayed above the spectrum and the measured 
concentration to the left has been adjusted for the dilution. 
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Saving a Data File 
 
The final step in acquiring a new measurement is to save the information in a data file. This is done 
very easily by clicking on the ‘Save Data File [F5]’ button at the bottom left-hand side of the screen. 
Saving the file is not automatic. However, if the user tries to leave the Acquisition mode without saving 
the data, or overwrites the current data without saving, he or she will be prompted by the software to 
save the new result. If you wish to make saving the file automatic refer to LightPilot Setup.  
 
After clicking on the ‘Save Data File [F5]’ button at the bottom left-hand side of the screen, the ‘Save 
As’ dialogue box appears allowing the customer to choose where the file will be saved and what it will 
be named (see Figure 21). 

 

 
Figure 21. The Save As dialogue box which allows the customer to choose where the file will be saved and 

what it will be named. 

 
Data files are saved with a ‘.spm’ extension as seen in Figure 21. The files include all sample 
information entered by the user and the complete spectrum obtained from the unknown sample, plus 
information about the calibration file used, the GPS locators, a date and time stamp, and the unit 
number. 
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‘Review’ Mode Display and Print Data Files 
 
The third mode of the LightPilot software is Review, and is used to display, examine, and print data 
files obtained from the various test samples. From the toolbar select the ‘Mode’ menu and then click 
on ‘Review’. No password is required, and the Review screen will be displayed.  

 
Click on ‘Add Data Sets’, and a dialogue box appears with a list of all the available ‘.spm’ files (see 
Figure 22). Double click the desired spectrum file or highlight the desired file and click open at the 
bottom of the dialogue box. 
 

 
Figure 22. The dialogue box that appears after clicking on ‘Add Data Sets’ in the Review Mode. This window 

allows the user to select the data file they would like to review. 

 
Once the file is selected the spectrum will be displayed in the middle of the screen while the file name 
is displayed above the spectrum as seen in Figure 23. 

 



 
 
 

 

 29 

 
Figure 23. The data file that was selected is now displayed in the Review Mode. 

 
Repeat the process to review and compare multiple spectra files at once. Finally, a report can be 
produced, previewed, and printed. To view your report, click on ‘View’, ‘Graph Type’, then ‘Report’.  
 
If you wish to print, click on ‘File’ then ‘Print’ or ‘Print Preview’ (see Figure 24). Note that you can print 
as pdf to save the report as a pdf file (see Figure 25). If you have multiple spectra displayed, a report 
will be printed for all the spectra at once. If you wish to only print one report, you must first remove the 
undesired spectra by selecting them and then clicking on ‘Remove Data’ until only the desired 
spectrum remains. 
 
The data report includes a copy of the spectrum, the calibration curve, results, and sample information. 
(see Figure 25). 
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Figure 24. The Print Preview of the Report generated by LightPilot. 
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Figure 25. The Print PDF of the Report generated by LightPilot. 

 
 
 

CONCENTRATION REPORT

Date 00:00:00 UTC  2070-01-01 

GPS  Loca tion ??N ?? W ?? m 

Name / Company Wilson Analytica l

Loca tion / Sampling point NABI Lab (S t. Albe rt)
Sample  Information

Calibra tion Curve CI-A 1 ppm- 100 ppm Calibra tion OPS 1084 07-Aug-2020
ppm = 0.00178 * x + -5.16
Rsquared = 0.9950
wave length = 503.0

Emiss ion / Concentra tion 31258 counts : 5.05e +01 ppm * 1

50.5 ppm

346 446 546 645 745 845 945 1044

-15

4451

8916

13381

17847

22312

26777

31243

0.00 14.29 28.57 42.86 57.14 71.43 85.71 100.00

0.00

8435.30

16870.59

25305.89

33741.19

42176.49

50611.78

59047.08

1/1
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